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Introduction

The TechSmith Deployment Tool is designed for Information Technology (IT) specialists or system
administrators responsible for installing Snagit throughout an organization. The tool enables the
administrator to customize and generate a Windows Installer Transform file (MST) and a BAT file.
To view or customize the individual registry settings for Snagit, see Snagit MSI Installation Guide.

N TechSmith’ Deployment Tool Guide | 3


https://www.techsmith.com/enterprise-resources.html
https://www.techsmith.com/

Download the Deployment Tool

1. Download the Snagit MSI file and the TechSmith Deployment Tool from
www.techsmith.com/enterprise-resources.html.

2. Double-clickthe TechSmith_Deployment_Tool.exe to launch the program.

Y,

-

TechSmith_De
yment_Tool

By default, the Deployment Tool generates the MST and BAT files into the same directory as where
the executableislaunched.
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Welcome Screen

L TechSmith Deployment Tool: Welcome — >

" Welcome Welcome to the TechSmith Deployment Toel. This tool will generate a Windows Installer®
7\ transform file (M3T) so you can customize Snagit, Camtasia Studic or TechSmith Relay Recorder
to suit your deployment needs,

This tool works with:

B Snagit (version 11 ar later)
Camtasia Studio (version 8 or later)

m TechSmith Relay Recorder (version 4.3 or later)

Download the latest Windows Installer® (MSI) from this webpage.

Alternatively, you can extract the MSI from your existing EXE download. Mote that the
executables are typically used for NET Framework detection and installation.
For Smagit 11 and Camtasia Studio, run the EXE on the command-line with the switch /.
For Snagit 12, install WiX 3.8. Then, run on the command-line:
dark %path%5Snagit.exe -x %outputpath?s.
For TechSmith Relay Recorder, extract the MSI by using a Zip utility.

Open MSI Package...

TechSmith Deployment Tool v1.4.0.38
Copyright © 2013-2016 TechSmith Corp. All rights reserved.

1. Onthe Welcome screen, click the Open MSI Package button.
2. Select the Snagit.msifile. If you have not previously downloaded the MSI file, download the file here.

3. Click Open.

The MSI file opensin the Deployment Tool and displays the available options for creating a custom MST file.
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Customize a Snagit Deployment

Click through the tabs on the left side of the TechSmith Deployment tool to view the custom options

available.
«ls TechSmith Deployment Tool (Setup_Snagit_x86_Release_EMU.msi): General Options — ot
n Welcome General Options
Begin by registering your software purchase and determining the installation path.
F, Import Settings Registration information
- : Username: | |
Hﬁ,-' General Cptions h Software Key: | |

Disable Snagit Settings Installation path

(® Use default installation path

Install Features ) Customize installation path:

TechSmith Fuse

Installation options

User Data Paths [] Create shortcuts on Desktop

Run Snagit when Windows starts

Add Snagit Outputs
Advanced options

) ) ) Snagit performs optimizations when it detects it is running in a virtualized environment.
Snagit Registry File Snagit can auto-detect most environments or you can select whether Snagit is running on
a virtual machine,

Uninstall Options Virtual Machine Optimization:

TechSmith Relay Options

Install Display Opticns

<

2
F
-
¥
R
3

&

Create Transform File

The following sections describe the options available on each screen:

« General Options
« Disable Snagit Settings

Install Features Options

TechSmith Fuse Options
User Data Path Options
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« Add Snagit Output Options
« Snagit Registry File Options
o Uninstall Options

« TechSmith Relay Options
« Install Display Options

o Create Transform File

Import Settings Options

L TechSmith Deployment Tool (Setup_Snagit_x36_Release EMU.msi): Import Settings — >

Welcome Import Settings
X\

Import a Transform File (mst) to use the previously selected settings.

Mote: Importing the transform file will reset your current Deployment Tool settings.
Jlk Impaort Settings

Open M5T File...

‘L:J General Options
Disable Snagit Settings
Install Features
TechSmith Fuse

User Data Paths

Mo @

e
—

o P

Add Snagit Outputs

Snagit Registry File

Uninstall Opticns

v

TechSmith Relay Options

d kJ

Install Display Opticns

\Tf Create Transfarm File

You can duplicate the settings used in a previously created MST file.

N TechSmith’ Deployment Tool Guide | 7



https://www.techsmith.com/

1. On the Import Settings tab, click the Open MST File button.

2. Browse to select the transform file (.mst).

Importing a transform file will reset your current Deployment Tool settings.

3. Click the Open button.

The Deployment Tool automatically selects the settings from the imported transform file.
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General Options

L TechSmith Deployment Tool (Setup_Snagit_x36_Release EMU.msi): General Options — o4
" Welcome General Options
- Begin by registering your software purchase and determining the installation path.
‘ * Import Settings Registration information
- Username:
-'L\:”;- General Options Software Key:

Disable Snagit Settings Installation path

@) Use default installation path

Install Features ) Customnize installation path:

TechSmith Fuse
Installation ocpticns

' User Data Paths [] Create shortcuts on Desktop

Run Snagit when Windows starts

Advanced options

Snagit performs optimizations when it detects it is running in a virtualized environment.
Snagit can auto-detect most environments or you can select whether Snagit is running on
a virtual machine,

Snagit Registry File

Uninstall Cpticns Virtual Machine Optimization: | Auto-detect ~

TechSmith Relay Options

=
F
|7
% Add Snagit Outputs
o
%
3

Install Display Opticns

'\Tf Create Transform File

Registration Information

Enter a username (e.g. your company or organization name) and the software key. If you have trouble
locating your software key, see Entering Your License Key article.

If you enter a software key, make sure to select the Disable online Snagit registration dialog option on the
Disable Snagit Settings screen in the TechSmith Deployment Tool.
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Installation Path
By default, Snagitis installed to the following location on a user's machine:

o On 32-bit Windows: %ProgramFiles%\TechSmith\Snagit<version>
o On 64-bit Windows: %ProgramFiles(x86)%\TechSmith\Snagit<version>

To select a custom location, click the Browse button or enter a path to the desired directory.

Installation Options
» Create shortcuts on Desktop: Creates shortcuts for Snagit and Snagit Editor on the desktop.

« Run Snagit when Windows starts: Starts Snagit and the Capture Window. Snagit Editor startsin the
background.

Advanced Options
Snagit performs optimizations when it detectsitis running in a virtualized environment. The performance
optimizationsinclude:

« Simplified appearance of the crosshairs when selecting an area to capture.

Optimizations On Optimizations Off

¢ Removed the shadow effect
¢ Do not extend the crosshair lines across the entire screen

¢ Removed the animation around the selected area
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e After selecting the area, the unselected area is not grayed out.

Optimizations On Optimizations Off

* When a large desktop is detected:

e Snagit limits visual changes across the entire desktop.
e Snagit limits unnecessary animations.

Snagit can auto-detect most environments or you can select to always apply these optimizations. Select one
of the following options:
o Auto-Detect: Apply the optimizations when it detects that Snagit is running on a virtual machine.

o Yes: Always apply the optimizations.

« No: Do notapply the optimizations.

Itis recommended to set this option to Yes when using virtualization technologies.

N TechSmith’ Deployment Tool Guide | 11


https://www.techsmith.com/

Disable Snagit Settings

s TechSmith Deployment Tool (Setup_Snagit_x36_Release_EMU.msi): Disable Snagit Settings — >

Welcome Disable Snagit Settings
N\

Check any of the following features you would like disabled.

‘ Import Settings [] Disable automatic updates

[ Disable online Snagit registration dialog
General Cptions
: [] Disable Image Capture
Disable Snagit Settings ML= C

[ ] Disable Printer Capture

[] Disable online help

TechSmith Fuse i i )
[] Disable usage reporting (TUDI) Maore Information

 User Data Paths [] Disable TechSmith account sign-in

F o
:E:| Install Features [] Disable TechSmith notification feed
|7

[] Disable Qutput Manager

w Add Snagit Outputs
% Snagit Registry File

» Uninstall Opticns

ok
m TechSmith Relay Options
g Install Display Opticns

'\T’ Create Transfarm File

When Should |
Description Consider Disabling
It?
. . . , e Asan
Automatically check for updates for Snagit. If disabled, the user will administrator
Automatic Updates not receive any application prompts when new versions are '
you want to

available. L
maintain control
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Description

When Should |
Consider Disabling

It?

Online Snagit
Registration Dialog

Image Capture

Video

N TechSmith’

After installing, the Snagit Registration dialog appears which
includes options to register the software online and to sign up for
product announcements, customer stories, and free tutorials.

Image capture takes a snapshot of anything on your screen
including a region, window, scrolling window, or the entire
screen.

Record, trim unwanted sections, and playback MPEG-4 or
Animated GIF videos in Snagit.

of application
updates across
the organization
and not allow
users to install
updates.

If you want to
require individual
users or user
groups to be on
a specific version
of the
application.

Turns off the
displaying the
online
registration
dialog for users.

Helps to prevent
user entered
errors when
registering the
software or
duplicating the
registration
information
online.

If you want to
disable image
capture
including image
capture presets
and options.

If users are
running Snagit
on a computer
that does not
support video
system
requirements.
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When Should |

Description Consider Disabling
It?

« Toallowan
administrator to
control
resources
(CPU/GPU/Band
width) when
deploying in
virtualized
environments.

o Ifrunning
Windows Server
2008 or
Windows Server
2008 R2 to
remove the video
capture and
playback options
for users. Video
playback and
decoding is not
supported on
this OS.

« When deploying

) Snagitinstalls as a printer destination for programs with printing n a.server
Printer Capture - environment (e.g.
capability. Remote Desktop

Services).
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Description

When Should |
Consider Disabling
It?

TechSmith
Notification Feed

N TechSmith’

Printer

HF Deskjet 3000 J310 series...
Ready

-

Adobe PDF
Ready

Fax
Ready

HF Deskjet 3000 1310 series
Offline

HF Deskjet 2000 1210 series Class Driver
Ready

Snagit 12
Ready

Doy o & ol

Snagit 13

Ready I}

Add Printer...

Print to File

Ifyou
disable
printer
capture,
make sure
to also
disable the
Snagit
Printer
option on
the Install
Features tab
of the
Deployment
Tool.

The Printer Capture Option scans the documentin a program and

opens the capture in Snagit Editor.

Show Snagit news, updates, and tips in the upper-right corner of

Snagit Editor.

Deployment Tool Guide | 15


https://www.techsmith.com/

When Should |

Description Consider Disabling
It?

rcark@techsmithcom « ) — ] "
Getting Started What's New? Current News  yy All ﬂ] Share

TechSmith Snagit [ W Follow |

@Snagit

Do you often send caplures to the same place? Create a
Profile to speed up the process. bityAZWS21d Fwin

Jan 26

Have you tried the Blur tool? Works great for blocking
sensitive Information you don't want others to see! ftips
Jan 25

Remaove personal Info such as a username, emall, or account
number to protect privacy In caplures. Heres how:
bty oloKY #tps

Oct 23

Working with multiple Images on one canvas? Right-click
and select Flatten All to treal them as a single object. #lips

May 20

Take your Image for a spin. Select an object on the canvas
and rotate it using the green handle. fips

May 18

Show more

o Ifthe websiteis
restricted in your
organization or if

connection. The online help provides content to assist in getting users do not

started in Snagit and to find answers to product questions. While have an internet
connection, you
can choose to

The Snagit help file is located online and requires an internet

offline, users can browse the basic help PDF located in Snagit. To

Online Help learn more, see Online Help Overview. disable the online
help. Disabling
The online help file is located this option opens
here: https://support.techsmith.com/hc/en- the basic help

PDF whenever a
user accesses
help in Snagit.

us/categories/200252218-Snagit- Windows-Documentation
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When Should |

Description Consider Disabling
It?

Ifyou
disable
online help,
we
recommend
providing
users access
to download
the full help
PDF located
here.

« When you must
follow internet
security
requirements
that restricts

Send anonymous data on Snagit usage to help TechSmith improve users from
future versions. Learn more about TechSmith User Design sending .data to
Initiative (TUDI). TechSmith.

o Or,ifyou do not
wantto
participate in the
feedback
program.

Usage Reporting
(TUDI)

« Signinis not

required for

users when a

single or multi-

user key is
TechSmith Accounts store user-specific information such as entered in the
license keys, your user profile, and Screencast.com and TechSmith Deployment
Relay logins. See About TechSmith Accounts. Tool.

TechSmith
Account Sign-In

« Signingintoa
TechSmith
account allows
users to share to
Screencast.com
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When Should |

Description Consider Disabling
It?

and TechSmith
Relay.

« YOu may
consider
disabling this
option if you do
not want to
require users to
have TechSmith
accounts in your
organization.

« Ifyouselectto
redirect the
outputs to a path

The Output Manager allows users to update, add, or remove other than the
Output Manager outputs from Snagit. To access the Output Manager in Snagit default.

Editor, select Share > Output Manager. « Ifyou do not

want to allow
users to update
the outputs.
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Install Features Options

L TechSmith Deployment Tool (Setup_Snagit_x36_Release EMU.msi): Install Features — o4

Welcome Install Features
N

Please select the features you would like to install.

31! * Import Settings Snagit Printer

- [] Windows Explorer Menu Extension
My Places

ﬁm, General Cptions 4 Snagit Outputs

- Microsoft Word Cutput

i i i Microsoft Excel Cutput
E Disable Snagit Settings Microsoft PowerPoint Output
Screencast Qutput

=1 Camtasia Output
: Install Features ‘r'c:uTubE Cutput

Google Drive Qutput

Dropbox Cutput

Microsoft OneMote 2013 Output
TechSmith Relay Output

g‘ User Data Paths [] Force installation of Microsoft outputs if Office is not installed on the target system
2

9!
w Add Snagit Outputs
% Snagit Registry File

Y

F TechSmith Fuse

W Uninstall Opticns

-

m TechSmith Relay Options

g Install Display Opticns

\Tf Create Transform File

Snagit outputs are add-ons to help users upload content to third-party websites and applications. The
outputs appear in the Share dropdown in Snagit Editor.
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More
=

[0 copy anl

™ Share

Share

R/
¢

File

FTP

Clipboard

Word

Excel

Screancast.com

TechSmith Relay

Google Drive

My Places

., OneDrive for Business

COERBPR &[] [

?  Share History £

Email

Program

Printer

PowerPoint

OneMote 2013

Camtasia Studio

Dropbox

Select which outputs are available to users. If you disable any of the options above, the output will not appear

on the Share tab for the end user.

Forexample, if YouTube isrestricted in your organization, you may want to remove the outputin Snagit.

Option

Snagit Printer

N TechSmith’

‘ Description

Snagit installs as a printer destination for programs with printing capability.
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Option ‘ Description

Printer

HF Deskjet 3000 J310 series...
= Ready

Adobe PDF
Ready

Fax
Ready

HF Deskjet 3000 J310 series
Offline

HP Deskjet 3000 1310 series Class Driver
Ready

Snagit 12
Ready

Snagit 13
Ready D}

Add Printer...

W e Wb

Print to File

The Printer Capture option scans the current documentin a program and
opens the capture in Snagit Editor.

Wi Expl : . .
indows XF.) orer Allows users to quickly send images to Snagit's Batch Converter.
Menu Extension
My Places allows users to set up shortcut locations to quickly import, export,
My Places or share your captures to a cloud storage destination such as OneDrive for
Business.

) The outputs appear in the Share dropdown in Snagit Editor and allow users
Snagit Outputs

to share their captures to popular destinations.
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Option ‘ Description

More  [F] copy Al [NERELEIE

Camtasia Studio -

B Screencast.com -

m TechSmith Relay L
.‘ Google Drive b

My Places

Share 7  Share History L3
- File Izl Email
@| FTP Program
il
Clipboard e=g Printer
@ Waord b m PowearPoint b
Excel . E] OneNote 2013 -
-

Dropbox b

., COnelrive for Business

Microsoft Word Output Allows users to insert an image from Snagit into a Microsoft Word document.

Microsoft Excel Output Allows users to insert an image from Snagit into a Microsoft Excel workbook.
Microsoft PowerPoint Allows users to insert an image from Snagit into a Microsoft PowerPoint
Output presentation slide.

Allows users to upload an image or video onto Screencast.com for hosting.
Screencast Output Screencast.com provides a URL for quick sharing or an embed code for
adding the capture onto a website or blog.

Allows users to import an image or video from Snagit into Camtasia Studio,
, , TechSmith's screen recording and video editing software.
Camtasia Studio Output ) ) i i
Note: You must have Camasia Studio version 7.0 or later installed to share

captures using this output.

Allows users to upload a video from Snagit onto YouTube for video hosting.
YouTube Output YouTube provides a URL for quick sharing to your audience or an embed
code for embedding the capture on a website or blog.

Google Drive Output Allows users to upload an image or video from Snagit onto Google Drive to
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Option ‘ Description
host content so itis accessible from any web browser or mobile device.

Allows users to upload an image or video from Snagit to Dropbox to host
Dropbox Output o . . .
content soitis accessible from any web browser or mobile device.
i i it i Not
OneNote 2013 Output Allows users to insert an image from Snagit into a Microsoft OneNote
notebook.

TechSmith Relay Allows users to upload an image or video to TechSmith Relay.

Output

Force installation of If Microsoft office is deployed to end users, select the Force installation of
Microsoft outputs if Microsoft outputs checkbox to force the installation of Snagit Outputs for
Office is notinstalled on Microsoft Office. If unchecked, the Snagit installation detects whether
the target system Microsoft Office is installed.
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TechSmith Fuse Options

“Ls TechSmith Deployment Tool (Setup_Snagit_x36_Release EMU.msi): TechSmith Fuse — o4

Mobile Sharing with TechSmith Fuse
Welcome 9
N

Mobile Sharing allows Snagit to receive files from TechSmith Fuse. TechSmith Fuse is a mobile
‘ _ app that allows you to send images and videos from your mobile device directly to Snagit. You
¥ Import Settings can capture, collaborate, and access your content - wherever you are,

Enable Techsmith Fuse

Configure this number if it conflicts with port numbers
5208
Port number. used in your organization,

General Options

B Disable Snagit Settings
=
:0:'| Install Features

F TechSmith Fuse

E" User Data Paths

9!
w Add Snagit Outputs
% Snagit Registry File

Y

W Uninstall Opticns

-

m TechSmith Relay Options

g Install Display Opticns

'\Tf Create Transform File

TechSmith Fuse is a mobile app that allows you to send images and videos from your mobile device directly to
Snagit. You can capture, collaborate, and access your content - wherever you are.

Fuse is available from the App Store, Google Play, or the Windows Store and supported on mobile devices
running the following operating systems:

« iOSversion 7 and later (phones and tablets)

« Android version 4.0 and later

o Windows 8.1 and later or Windows RT
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Some security settings and wireless network environments may not allow connectivity to a desktop.
Make sure to validate port 8298 is open to the desktop when working in a virtual environment.
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User Data Paths Options

L TechSmith Deployment Tool (Setup_Snagit_x36_Release_EMU.msi): User Data Paths — o4

Welcome Customize User Data Paths
N

In this page you can customize the location of the user data,

. Automatically stored files
‘ ¢ Import Settings

Snagit automatically saves all captures into the selected folder below.
Mote: The location cannot be shared by multiple users or accessed by a single user from

General Options two locations at the same time.
@) Use default location [ZeLOCALAPPDATASE TechSmith\Snaglt\DataStore)
oy tom folder:
B Disable Snagit Settings — CsE custem ToiEr
Make sure to include environment variables (e.g. %USERNAME?) to create a
e unigque location for each user,
:‘::| Install Features Allow users to change the automatically stored files location

Installed outputs

F TechSmith Fuse Select the directory to store installed ocutputs such as Woerd, Excel, Google Drive, YouTuke,

etc.

E{a User Data Paths ® Use default location (SELOCALAPPDATASE TechSmith\Snaglt\Accessories)
]

() Use custom falder:

=]
w Add Snagit Outputs For virtualized environmenits, you should use a location that is common and

available to all users. For 64-bit environment, we suggest you use:
%COMMOMNPROGRAMFILES(x86)%6\TechSmith Shared\Snaglt\Accessories
% Snagit Registry File

Other user settings

3-.- Uninstall Options S.elect the directory to store user settings such as Quick Styles, Cached Thumbnails, TUDI
e A files, etc.
@) Use default location (ZeLOCALAPPDATAS TechSmith\Snaglt)
TechSmith Relay Options —~
() Use custom folder:

Make sure to include environment variables (e.g. %USERNAMET) to create a
g Install Display Opticns unigue location for each user,

'\Tf Create Transform File

You can change or customize the location for storing user data on the User Data Paths screen.

Automatically Stored Files

Snagit automatically saves all capturesinto the DataStore folder. The default location for this folder is:
%LOCALAPPDATA%\TechSmith\Snagit\DataStore.

To help prevent users from losing data and to limit users from changing the path, it is recommended to
disable the option in the Deployment Tool to Allow user to change the automatically stored files location.

This option for usersis located in Snagit Editor, select File > Editor Preferences > Library tab > Library location.
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Installed Outputs
The Snagit Outputs appearin the Share dropdown in Snagit Editor and allow users to share their captures to

popular destinations.

More [ Copy Al
Share 7  Share History -ll‘.[-l
File [=" Emai
FTP ’_‘ Program

Clipboard =2 Printer

Word - @ PowerPoint -
Excel - E] OneNote 2013 -

Screencast.com - Camtasia Studio -

2R Ee T

TechSmith Relay  w u YouTubs -
‘ Google Drive - g Dropbox =
My Places

‘ Onelrive for Business

The default location to store the installed outputsis: %LOCALAPPDATA%\TechSmith\Snagit\Accessories.
If you select a custom folder to store the installed accessories, consider the following items:

o Forroaming profiles, you should use a location that is common and available to all users.

« If auserdoesnot have write access to the folder, Snagit disables the ability for users to update or remove
outputs from the Output Manager in Snagit Editor.

o For64-bitenvironment, Itisrecommended to use: %ProgramFiles
(x86)%\TechSmith\Snagit13\Accessories

Other User Settings
User settings such as quick styles, cached thumbnails, additions to the spelling dictionary, TUDI files, etc. are
stored by defaultin: %LOCALAPPDATA%\TechSmith\Snaglt.
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Add Snagit Outputs Options

Snagit outputs are add-ons designed to allow users to upload content to third-party websites and

applications. The outputs appear in the Share dropdown in Snagit Editor.

Mere
Share
I Fe
[®] Fe
i Clipboard
'-‘.'a Word -
Excel -
Screencast.com -

kel (0

My Places

‘ Onelrive for Business

TechSmith Relay -

‘ Google Drive -

?  Share History £¥

E| Email

Program

Printer
PowerPoint
OneMote 2013
Camtasia Studio

YouTube

Dropbox

COERR O[]

Snagit offers a number of convenient outputs available on the TechSmith website:

http://www.techsmith.com/snagit-outputs-windows.html.
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L TechSmith Deployment Tool (Setup_Snagit_x36_Release EMU.msi): Add Snagit Outputs — >

Welcome Add Snagit Outputs
X\

By default, Snagit includes outputs to programs such as Microsoft Word and PowerPaint. You can
_ include additional outputs such as Twitter or OneNote, View the list of
x_:_! * Import Settings available outputs on our website.

General Options

B Disable Snagit Settings @
=
:0:'| Install Features

F TechSmith Fuse

E" User Data Paths

% Snagit Registry File ) i . .
WARNING: Some Snagit outputs may have different system requirements than Snagit.

W Uninstall Opticns

-

m TechSmith Relay Options

g Install Display Opticns

'\Tf Create Transform File

The outputs selected on the Install Features screen are included in the installation. To include additional
outputs:

1. Download the additional outputs to include with deployment from this website:
http://www.techsmith.com/snagit-outputs-windows.html.

2. Onthe Add Snagit Outputs screen, click the Add button.

3. Browse and select the desired .snagacc file. Control-click to select multiple files.

4. Click Open.
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Snagit Registry File Options

«Ls TechSmith Deployment Tool (Setup_Snagit_x36_Release EMU.msi): Snagit Registry File — >

" Welcome

l * Import Settings

General Options

B Disable Snagit Settings
=
fi| Install Features

F TechSmith Fuse

E User Data Paths
=
H Add Snagit Outputs

% Snagit Registry File

W Uninstall Opticns

-

m TechSmith Relay Options

g Install Display Opticns

'\Tf Create Transform File

Snagit Registry File

You may include a customized Snagit registry file with the deployment. The most commeon reasons
for doing so are to distribute Snagit with profiles specific to your environment and opting out of
our TUDI (ancnymeous usage data collection), While other options and preferences are contained in
the REG file, Quick Styles and Stamps cannot be customized and deployed with Snagit.

The easiest way to obtain the customized registry file is to set up Snagit the way you want on
your computer. Then, exit Snagit completely and select the third option below.

®) Do not customize Snagit registry settings

) Customize Snagit registry settings by importing a Snagitreg file:

File name:

Customize Snagit registry settings by using this computer's settings

The registry file contains custom settings within the Snagit application such as presets, appearance settings,

and hotkeys.

Some of these custom settings are located in the following locations:

o Inthe Capture Window, select File > Capture Preferences.

« In Snagit Editor, select File > Editor Preferences.
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Stamps, Quick Styles, and optionsin the toolbar are not stored in the registry file and cannot be
deployed to multiple users.

To deploy custom Snagit settings to multiple users:
1. Install Snagit.
2. Setup Snagit with the desired settings and customizations for your organization.
3. Close Snagit.
4. Run Command Prompt asan administrator.
5

. Make sure Snagitis not running. To create the Snagit registry file on your desktop, enter the following
into the Command Prompt:
c:\Program Files (x86)\TechSmith\Snagit 13\Snagit32.exe" /e XHOMEPATH%\Desktop\Snagit.reg

6. Inthe TechSmith Deployment tool, click the Snagit Registry File tab and select Customize Snagit registry
settings by importing a Snagit.reg file.
7. Click the Browse button to select a Snagit.reg file produced in step 5.
The transform (MST) file generated from the Deployment Tool will use the settings from the registry as the

default settings when installing Snagit.
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Uninstall Options

L TechSmith Deployment Tool (Setup_Snagit_x36_Release EMU.msi): Uninstall Options — o4

" Welcome

‘ * Import Settings

General Options

B Disable Snagit Settings
=
:0:'| Install Features

F TechSmith Fuse

E" User Data Paths

9!
w Add Snagit Outputs
% Snagit Registry File

-

.}k Uninstall Opticns

L)

m TechSmith Relay Options

g Install Display Opticns

'\Tf Create Transform File

Uninstall Options
During uninstall, Snagit prompts the end user with the following dialeg:

M TechSmith Snagit”

@ Keep Files

[ plan 1o reéinstall &r hawe upgraded Snagit.
Egep my unsaved captunes, flags, keywords,
and caplure information.

Delete Files
Ramowd unsavied caplures. Remond kiywornds,
'.|J_q£. and infanmation dddocdled vath saved

capiunes.
This affects all installations of Snagit.

When deploying an uninstall, users will be prompted with the above dialeg, unless you choose to
keep or delete the user's files below.

® Prompt users with this dialog
) Keep files

) Delete files

When uninstalling Snagit, you can choose to keep or delete the user’'s Snagit files including unsaved
captures, flags, tags, and capture information. If you plan to reinstall or upgrade Snagit for this user, we

recommend keeping these files.

Select one of the following options on the Uninstall Options screen:

o Prompt users with this dialog: When uninstalling Snagit, allow the user to select whether to keep or

delete their files.

« Keep files: Automatically keep the user’s files when uninstalling Snagit. Users are not prompted with this

dialog.
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« Delete files: Automatically deletes the user’s files when uninstalling Snagit. Users are not prompted with
this dialog.
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TechSmith Relay Uploader Options

The Relay Uploader Options configures Snagit with an output to your specific TechSmith Relay instance. For
this configuration, you need to enter both the primary endpoint (server URL) and Team ID.

The primary endpoint value is the web address of your TechSmith Relay Server ending in rest.ashx. For
example, http://www.organziation.com/relay/rest.ashx.

The method for retreiving your Team ID depends on your implementation of TechSmith Relay.

« If you have TechSmith Relay (Self-Hosted), you can log in to the TechSmith Relay website asan
administrator and find it on the Servers page.

B Techsminh Retay X |+ -

[=]
“— O £ onganization.com +r = @A 5:3

X

M TechSmith Relay’

System Presentations Profiles Lisers Clhient Downiloads. 1]
¥ SHIONG 3 e User: Relay Administrater {relayadmin] Sion Oul
TechSmith Ralay Sarvers Team 1D asabdcb0-9cac-4190-b461-a912a 1508241
Sintus  Server Hame Version  Last Updated ; P”"a“im’@
www organization com 507 SAP0F016 65505 PM [ 0 10,354

Transcription Job Couwnl Encoding Job Couwnd

@ WA OrganZation. com

f:“'-:mm x;;.iﬂ‘lﬁ 18:5505 (& Pandioo ’ (& Pande "
81 H |
Manager Service Pid: 10076 & Quaved 0 & Cumed L]
En-:_odl!'rg License:  Large &) Processing o ) Paocessing ]
Activation Status: Activaied a Fallad o B Failed [
Presentations ane being accepted and processed on this @ Completed 2361 @ Compiaied 12042
SErVEL.
Publish Job Count
Take Sorver Offine .
{x: Pending 16
& Gueved 0
2 Processing ]
&) Fallad 0
&) Completed 11,897

« If you have TechSmith Relay (Hosted), you can locate the Team ID on the Download Recorders page.

1. Fromyour TechSmith Relay homepage, click the Create button and then click the Download
Recorders link.

2. Onthe Download Recorder page, right-click the Configure Snagit button and Copy the link
address.

3. Pastethelinkinto a text editor and extract the unique Team ID.

Finally, it is not recommended that you check the option to ignore server certificate warnings.
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Install Display Options

chSmith Depls
’! Welcome 8 Display Options
When the deployment is in progress and Snagit is installing, there are a number of options that
will determine what the end user sees on their screen If you don’t want the user to see anything,
.;;.:.. General Options select Quiet display (/quiet). Visit the MSDN website for additional details.
E Disable Snagit Settings
Display Options
Ej Install Features & Quiet display (fquiet)
Passive display [ passive)

'F TechSmith Fuse

E Usar Data Paths

iﬂ Add Snagit Accessories Restart Options

@ Do not configure the restart options

) Prampt before restarting (/promptrestart)
! Mever restart [fnorestart)

= | Blways restart {[forcerestart)

}‘. Uninstall Options

#*  Install Display Options

Iﬂh": Create Transform File

‘ Snagit Registry File

Select one of the following options:

« Quietdisplay: Installs Snagit silently with no setup interface displayed. May be run from a non-
administrator command prompt. It will not return the command prompt until Snagit has finished
installing.

« Passive display: Installs Snagit from an administrator command prompt. It returns the command prompt
immediately (hon-blocking). The minimal setup is displayed and Snagit notifies the user when the
installation is complete.
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Create Transform File

- TechSmith Deployment Tool (snagit(1).msi: Create Transform File

’! Welcome

-I::.- General Options

F TechSmith Fuse

E Usar Data Paths
L.
* Add Snagit Accessarnies

“ Snagit Registry File

5" Uninstall Options

m Install Display Options

@ Create Transform File

Software License Agreement

END-USER LICENSE AGREEMENT FOR TECHSMITH SOFTWARE -
SMAGIT for
Windows or Mac

IMPORTANT-READ CAREFULLY: This TechSmith Software License
Agreement

("TSLA%) is a legally binding license agreement between You and
TechSmith for the TechSmith SOFTWARE PRODUCT or SOFTWARE
identified above and as further defined in this TSLA

BY PAYING THE LICENSE FEE FOR THE SOF TWARE PRODUCT OR
SOFTWARE WITHOUT PROMPTLY REQUESTING A REFUND OF
SUCH FEE OR INSTALLING, COPYING, OR OTHERWISE USING
THE SOFTWARE PRODUCT OR SOFTWARE IN ANY MANNER,
SUCH ACTS INDICATE YOUR ACCEPTANCE OF THIS TSLA AND
¥OUR AGREEMENT TO BE BOUND BY THE TERMS AND
CONDITIONS OF THIS TSLA. IF YOU DO NOT DESIRE TO ACCEPT
THIS TSLA OR AGREE TO THE TERMS AND CONDITIONS OF THIS
TSLA, PROMPTLY RETURN THE UNUSED SOFTWARE PRODUCT

T T LS R BRSO R G

[T11 have read and accept the End User License Agresment

Transform file:  Ci\UsersiraclENDowndoads\snagit{1).mst

Eatch file: CAlisers\rac 18T\ Downlosds\snagit(1) bat

[ Create Transform... |

| (@)

o

Click the Create Transform button to generate the following files based on the options selected within the

Deployment Tool:

o Transform file (MST)

« Batch Processing file (BAT)
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Additional Resources

Enterprise Resources

o TechSmith Enterprise Resources website
Download other resources and guides to assist with Snagit enterprise installations.

« Snagit MSI Installation Guide
View or customize the individual registry settings for Snagit.

Technical Support

We're here for you! Visit the Technical Support website to submit a ticket, find answers online, or contact an
expert.
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